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Abstract

Repeated injury to airway tissue can impair lung function and cause chronic lung disease, such 

as chronic obstructive pulmonary disease. Advances in regenerative medicine and bioreactor 

technologies offer opportunities to produce lab-grown functional tissue and organ constructs that 

can be used to screen drugs, model disease, and engineer tissue replacements. Here, a miniaturized 

bioreactor coupled with an imaging modality that allows in situ visualization of the inner lumen 

of explanted rat trachea during in vitro tissue manipulation and culture is described. Using this 

bioreactor, the protocol demonstrates imaging-guided selective removal of endogenous cellular 

components while preserving the intrinsic biochemical features and ultrastructure of the airway 

tissue matrix. Furthermore, the delivery, uniform distribution, and subsequent prolonged culture 

of exogenous cells on the decellularized airway lumen with optical monitoring in situ are shown. 

The results highlight that the imaging-guided bioreactor can potentially be used to facilitate the 

generation of functional in vitro airway tissues.

Introduction

The luminal surface of the respiratory tract is lined by a layer of epithelium that mainly 

consists of multi-ciliated, club, goblet, and basal stem cells1 , 2. The epithelial layer serves 

as a primary defense mechanism of the lung, acting as a biophysical barrier that protects 
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the underlying airway tissue against inhaled pathogens, particulates, or chemical gases. It 

protects the airway tissue via multiple mechanisms, including intercellular tight junction 

formation, mucociliary clearance, and antimicrobial and antioxidant secretion3 , 4. The 

defective airway epithelium is associated with devastating respiratory diseases, such as 

chronic obstructive pulmonary disease (COPD)5, primary ciliary dyskinesia (PCD)6, and 

cystic fibrosis (CF)7.

Advances in lung-on-chip (LOC) technology represent an opportunity to study human lung 

development, model various lung diseases, and develop new therapeutic materials in tightly 

regulated in vitro environments. For example, airway epithelium and endothelium can be 

cultured on opposite sides of a thin, porous membrane to mimic the gas exchanging lung 

tissue, allowing faithful disease modeling and drug testing8. Similarly, in vitro disease 

models have been created to model airway diseases in vitro, such as COPD9 and cystic 

fibrosis10. However, a major challenge of LOC devices is recapitulating the complex three-

dimensional (3D) architecture of the lung tissue and dynamic cell-tissue matrix interactions 

in vitro11.

Recently, innovative tissue engineering methodologies have been developed that allow 

manipulation of ex vivo lung tissues12. Using these methodologies, denuded allogenic or 

xenogeneic tissue grafts can be prepared by removing the endogenous cells from the lung 

tissue via chemical, physical, and mechanical treatments13. In addition, the preserved native 

tissue extracellular matrix (ECM) in the decellularized lung scaffolds provide the physio-

mimetic structural, biochemical, and biomechanical cues for implanted cells to attach, 

proliferate, and differentiate14 , 15.

Here, an imaging-guided bioreactor system created by combining LOC and tissue 

engineering technologies to allow in vitro tissue manipulation and culture of explanted rat 

tracheal tissues is reported. Using this airway tissue bioreactor, the protocol demonstrates 

selective removal of the endogenous epithelial cells without disrupting the underlying 

subepithelial cellular and biochemical components of the airway tissue. We next show the 

homogenous distribution and instantaneous deposition of the newly seeded exogenous cells, 

such as mesenchymal stem cells (MSCs), on the denuded airway lumen by instilling the cell-

loaded collagen I pre-gel solution. In addition, by using the micro-optical imaging device 

integrated into the bioreactor, the visualization of the trachea lumen during epithelium 

removal and endogenous cell delivery is also done. Further, it is shown that the trachea and 

newly implanted cells can be cultured in the bioreactor without noticeable cell death and 

tissue degradation for 4 days. We envision that the imaging-enabled bioreactor platform, 

the thin film-based de-epithelialization technique, and the cell delivery method used in this 

study can be useful for generating airway tissues for in vitro disease modeling and drug 

screening.

The bioreactor includes a rectangular chamber connected to a programmable syringe pump, 

perfusion pump, and ventilator for culturing isolated rat trachea. The bioreactor features 

inlets and outlets connected to the trachea or the tissue culture chamber to separately supply 

reagents (e.g., culture media) to the internal and external spaces of the trachea (Figure 1). 

A custom-built imaging system can be used to visualize the interior of the in vitro-cultured 
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rat trachea at the cellular level (Figure 2). The endogenous epithelium of the trachea is 

removed via the instillation of a detergent-based decellularization solution followed by 

vibration-assisted airway washing (Figure 3). Hydrogel solution, such as type I collagen, is 

used as a delivery vehicle for seeding exogenous cells uniformly and instantaneously across 

the denuded trachea lumen (Figure 4). All the materials used to construct the bioreactor and 

conduct the experiments are provided in the Table of Materials.

Protocol

The animal tissue protocol below has been approved by the animal welfare guideline and 

regulations of the Institute for Animal Care and Use Committee (IACUC) at Stevens 

Institute of Technology, and it complies with the National Institutes of Health (NIH) 

guidelines for the use of experimental animals.

1. Design and construction of imaging-guided rat trachea bioreactor

1. Designing and fabrication of rat trachea bioreactor

1. Create a computer-aided design (CAD) model of the bioreactor 

chamber with relevant design, such as inlets, outlets, and tissue culture 

chamber, using CAD generator software. For this study, use the 

geometry and dimensions presented in Figure 1A-C. The tutorial of 

CAD generator software can be found in16 , 17.

2. Export the generated CAD model to a computer numerical control 

(CNC) controller software and cut the polytetrafluoroethylene (PTFE) 

plastic using a CNC machine to create the bioreactor chamber. The 

tutorial of the CNC controller software can be found in18.

NOTE: In addition to PTFE, other plastic materials, such as ultra-high 

molecular weight polyethylene (UHMWPE) and polyetherimide can be 

used to fabricate the culture chamber.

3. Sterilize all bioreactor components, such as Luer adapters and screws, 

to avoid contamination of the tissues and cells cultured in the device. 

Assemble all bioreactor components to the main tissue culture chamber 

in a clean environment (Figure 1A).

2. Construction of gradient index (GRIN) lens-based imaging device

1. To create the in situ imaging device, insert a tube lens into a stackable 

lens tube and secure it using a retaining ring. Mount the lens-tube 

assembly onto a scientific CMOS camera via a C-mount adapter.

2. Use software, such as Micro-Manager, to operate the camera and 

acquire photos and videos. Aim an object located at a long distance 

(e.g., 10 m from the camera) and adjust the distance between the tube 

lens and imaging sensor of the camera until a focused image of the 

object is formed on the computer screen by the imaging software being 

used.
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3. Mount a filter lens on a dual-edge super-resolution dichroic mirror and 

a laser to the device using optical cage system components, including 

assembly rod, threaded cage plate, and cage cube.

4. Connect the objective lens (20x) to the device. Mount a GRIN lens 

(diameter = 500 μm) at the distal end of the lens tube via the XY 

translator. Adjust the distance between the GRIN lens and the objective 

lens to form focused microscopic images (Figure 2A,B).

2. Isolation of the rat trachea

1. Sanitize the surgical area and sterilize the surgical instruments using an autoclave 

at 121 °C for 30 min prior to the surgery.

2. Place a rat in the induction chamber and deliver 2.5% of isoflurane for 15 min 

using a small vaporizer to anesthetize the animal. Assess the anesthesia depth by 

pedal reflex. To do this, firmly pinch the toe and confirm that the animal does not 

respond to the toe pinch.

3. After anesthesia, remove the isoflurane from the chamber and administer 1 mL 

of 1,000 unit/mL heparin through the lateral tail vein to prevent blood clotting in 

the pulmonary vasculature.

4. To euthanize the animal, expose the animal to 5% isoflurane for an additional 

15-20 min. Remove the animal from the induction chamber and place it on the 

surgical board in a face-up supine position.

5. Fix the rat on the surgical board by immobilizing the legs and tail using adhesive 

tape. Next, sterilize the rat's neck and chest regions using 70% isopropyl alcohol 

(IPA). Open the abdominal cavity by making a 3-4 cm incision using scissors in 

the skin.

NOTE: Be careful not to cut the skin deeply by pointing the tips of the scissors 

upward.

6. Transect the inferior vena cava (IVC) using the scissors and confirm the 

euthanasia by exsanguination.

7. Perform the tracheotomy by making an incision using scissors in the midline of 

the neck and exposing the trachea. Perform midline thoracotomy by making an 

incision in the chest wall and cutting between the ribs to reach the trachea end 

connected to the lung. Next, use a bicep and scissors to cut both ends of the 

trachea and isolate the trachea.

8. After isolation, rinse the trachea using 20 mL of 1x phosphate-buffered saline 

(1x PBS). Transfer the trachea to the bioreactor using sterilized biceps. Secure 

the two ends of the trachea to the Luer connector using a 4-0 suture thread.

9. Deliver 5 mL of culture medium to the bioreactor chamber using the 

programmable syringe pump through the tubing connected to the bioreactor 

chamber at a flow rate of 5 mL/min.
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NOTE: The culture medium is composed of Dulbecco's modified Eagle's 

medium (DMEM), recombinant human FGF-basic (0.1 ng/mL), fetal bovine 

serum (FBS, 10%), and antibiotic-antimycotic (1%).

10. Tightly close the bioreactor lid with the acrylic plastic lid and screws. Close 

the bioreactor chamber tubing connections with the male/female Luer plugs to 

prevent the flow of the culture medium in the tubing.

3. Imaging-guided removal of the trachea epithelium

1. To visualize the trachea lumen either in bright-field or fluorescent, place the 

bioreactor on the imaging stage (Figure 3A).

2. Prepare carboxyfluorescein succinimidyl ester (CFSE) solution (concentration: 

100 μM) in the CFSE cell labeling kit by diluting the CFSE solution with 1x 

PBS.

NOTE: The concentration of the original CFSE solution is 10 mM (in dimethyl 

sulfoxide (DMSO)).

3. Infuse 500 μL of the CFSE solution through the trachea via the syringe pump 

through the tubing connected to the trachea cannula at a flow rate of 5 mL/min. 

Stop the pump when the CFSE solution fills the trachea. Wait for 10 min, and 

then wash the trachea lumen by infusion of 10 mL of 1x PBS using the syringe 

pump to remove the residual unincorporated CFSE reagent.

4. Insert the distal imaging end of the GRIN lens into the trachea via the Luer 

connector attached to one end of the trachea. Then, gently move the GRIN lens 

inside the trachea until the trachea surface is focused and take photos and videos 

in bright-field or fluorescence at 20x magnification.

5. For capturing bright-field images in the Micro-Manager software follow the steps 

below.

1. Introduce white light through the cage cube to illuminate the trachea 

lumen. Click on the Live icon to show the luminal surface of the 

trachea in real-time. Use Imaging Setting > Exposure (ms) to change 

exposure time to the desired value. In this study, the exposure time used 

was in the range of 10 ms and 50 ms.

2. To adjust the contrast and brightness of images, use the Histogram 
and Intensity Scaling window to move black and white arrows at 

the endpoint of the interactive histogram display. Alternatively, use the 

Auto Stretch option that allows the software to adjust the brightness 

and contrast automatically to optimal levels.

3. Click on the Snap icon to freeze the image. Then, use Setting > 
Export Images as Displaced to save the images in the desired format. 

Alternatively, use Setting > ImageJ to directly export the image to the 

ImageJ software and save it.
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6. To obtain photos and videos in fluorescent mode, illuminate the trachea lumen 

with CFSE-specific laser light (CFSE: excitation wavelength: 488 nm, emission 

wavelength: 515 nm) through the cage cube. Follow the steps 3.5.2-3.5.3 to 

acquire the images. After taking photos and videos, gently remove the GRIN lens 

from the trachea.

7. Perform de-epithelialization as described below.

1. Prepare 2% sodium dodecyl sulfate (SDS) decellularization solution in 

distilled (DI) water. Instill 50 μL of SDS through the trachea at a flow 

rate of 6.3 mL/min, by using the syringe pump through the trachea 

cannula to generate a thin film of the detergent solution on the trachea 

lumen.

2. Close the bioreactor's tubing connections using male/female Luer plugs 

and transfer the bioreactor to an incubator. Allow the SDS to dwell 

within the trachea for 10 min at 37 °C. Instill another 50 μL of SDS 

solution through the trachea and incubate for 10 min.

3. Remove lysed epithelium and SDS by irrigating the trachea lumen with 

500 μL of 1x PBS via syringe pump at a flow rate of 10 mL/min for 3x. 

Place the bioreactor on a shaker and mechanically vibrate the bioreactor 

at 20 Hz frequency and displacement amplitude of approximately 0.3 

mm to physically promote detachment of SDS-treated epithelial cells 

from the trachea lumen.

NOTE: In this study, the shaker was custom-built by assembling a 

subwoofer speaker, a subwoofer plate amplifier, and an accelerometer. 

A sinusoidal waveform was generated by a computer and fed into 

the shaker via the amplifier, while the response of the shaker was 

monitored via the accelerometer (Figure 3B). In addition, conventional 

shakers, such as electromagnetic and inertia shakers, can be used to 

promote the detachment of the cells. To do this, set the frequency and 

acceleration of the shaker to 20 Hz and 0.5 g, respectively (equivalent to 

0.3 mm displacement amplitude).

4. Instill 500 μL of 1x PBS twice through the trachea lumen to remove 

residual SDS and cell debris while the trachea is mechanically vibrated. 

Following the epithelium removal procedure, evaluate the clearance of 

the epithelial layer by measuring the intensity of CFSE using the GRIN 

lens imaging device as in step 3.6 (Figure 3C).

4. Trachea tissue preparation for further analyses

1. To confirm the epithelium removal, perform further tissue analyses, such 

as hematoxylin and eosin (H&E) staining, trichrome, pentachrome, and 

immunostaining. To do this, remove the trachea from the bioreactor, and fix 

it in 30 mL of 4% neutral buffered paraformaldehyde solution in 1x PBS (pH = 

7.4) at 4 °C overnight.
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2. Dehydrate and embed the fixed trachea tissue by following the steps below.

1. After fixation, wash the trachea tissue with 10 mL of 1x PBS, transfer 

the trachea to 30 mL of 70% alcohol, and keep it at 4 °C overnight. Cut 

the trachea into small cylindrical sections (~5 mm) using a sharp blade 

and insert the tissue sections in the tissue embedding cassettes (length x 

width x height: 4 cm x 2.5 cm x 0.5 cm). Keep two trachea sections in 

each cassette.

2. Dehydrate the sections in a series of isopropyl alcohol (IPA) solutions - 

85%, 90%, 95%, 100% - for 1 h in 30 mL of each solution. Remove the 

previous solution before adding the next solution.

3. Upon completion, submerge the cassettes in 30 mL of clearing agent 

(e.g., xylene) for 2 h to displace the IPA solution from the tissue 

sections completely. Perform this step in a fume hood with proper 

ventilation.

4. Submerge the cassettes in paraffin for 2 h, and then embed them in 

paraffin at 4 °C overnight. Next, cut the paraffin-embedded tissues 

into thin sections (5-8 μm) using a microtome device for the H&E, 

trichrome, pentachrome, and immunostaining.

3. To prepare the tissues for scanning electron microscopy (SEM) analysis, fix the 

trachea in 30 mL of 2.5% glutaraldehyde solution in 1x PBS (pH = 7.4) at 4 

°C overnight. Then, dehydrate the fixed trachea tissue for SEM by following the 

steps below.

1. After fixation, rinse the trachea tissue with 10 mL of 1x PBS. Cut the 

trachea tissue longitudinally into small semi-cylinder sections (length: 

~5 mm) using scissors and insert the tissue sections in the cassettes.

2. Dehydrate the sections in a series of IPA solutions - 35%, 50%, 70%, 

85%, 95%, and 100% - for 10 min in 30 mL of each solution. Remove 

the previous solution before adding the next solution.

3. Perform hexamethyldisilazane (HMDS)-based drying method by 

submerging the tissues in the following solutions: 100% IPA: HMDS 

(2:1; v/v) for 10 min, followed by 100% IPA: HMDS (1:2; v/v) for 10 

min, and finally 100% HMDS for overnight.

NOTE: HMDS is toxic. Work under a fume hood during all drying 

steps.

4. Remove the tissues from the HMDS solution and allow them to dry 

under the fume hood for 1 h. Mount the section on aluminum pin stubs 

using a carbon double-sided conductive tape or silver conductive paste 

for SEM imaging.
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5. Homogeneous distribution of exogenous cells onto the denuded tracheal lumen

1. Prepare a de-epithelialized rat trachea using the protocol in step 3. Thaw frozen 

mesenchymal stem cells (MSCs) for 30 s in a 37 °C water bath.

NOTE: In this study, we used mesenchymal stem cells (MSCs) as a model cell 

to show the distribution of exogenous cells onto the de-epithelialized trachea. 

Ideally, primary airway epithelial cells, basal cells, or induced-human pluripotent 

cells (iPSCs) can be used for epithelium regeneration purposes.

2. Count the cells with a hemocytometer and prepare a cell solution with a 

concentration of 5 x 106 cells/mL. Label the cells fluorescently by incubating the 

cells with 2 mL of CFSE solution (concentration: 100 μM) at room temperature 

for 15 min. Rinse the cells with 5 mL of 1x PBS for 3x and resuspend the cells in 

fresh culture medium at a final concentration of 3 x 107 cells/mL.

3. Prepare hydrogel pre-gel solution as a vehicle for cell delivery. For this study, 

use collagen I as a delivery vehicle for MSCs cells and follow the manufacturer's 

instructions to prepare the pre-gel. For example, to obtain 3.6 mg/mL collagen 

pre-gel, mix one part of the chilled neutralization solution with nine parts of the 

rat tail collagen in a 1.5 mL sterile tube. Then, gently pipet the mixture up and 

down for adequate mixing.

NOTE: Other biocompatible hydrogels may be used instead of collagen I 

according to the study and user needs.

4. Once the hydrogel solution is prepared, add the cells quickly to the solution with 

desired concentration (e.g., 5 x 106 cells/mL). To obtain a uniform cell-hydrogel 

mixture, mix the cells and gel solution by gently pipetting with a micropipette.

5. Attach one end of the trachea within the bioreactor to a programmable syringe 

pump through a Luer connector. Deliver 5 mL of fresh culture medium at 37 °C 

into the bioreactor chamber to cover the exterior surface of the trachea using the 

syringe pump at a flow rate of 5 mL/min.

6. Administer a 10 μL bolus of the cell-hydrogel mixture into the de-epithelialized 

trachea within the bioreactor using the syringe pump at a flow rate of 5 mL/min 

to generate a cell-hydrogel layer on the trachea lumen (Figure 4).

7. After cell injection, place the bioreactor in a sterile cell culture incubator at 37 

°C and 5% CO2 for gelation. For collagen I, the gelation occurs in 30 min.

8. To visualize the distribution of implanted cells, sterilize the GRIN lens by wiping 

with 70% IPA or ethanol and place the bioreactor on the imaging stage. Take 

photos and videos in both bright-field and fluorescent modes as needed.

9. After 30 min of cell seeding, infuse 1 mL of culture medium into the trachea 

lumen using a syringe pump at a flow rate of 1 mL/min.

10. Culture the cell-seeded trachea within the bioreactor in an incubator at 37 °C for 

the desired time. For longterm culture, refresh the culture medium in the trachea 

lumen and the bioreactor chamber every 24 h. During the cell culture, keep the 
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media inside the lumen static and change it every 24 h, while the media outside 

the trachea is continuously perfused via a unidirectional flow at 5 mL/min.

11. After culturing the cells for a certain time period (e.g., 1 and 4 days in this 

study), remove the trachea from the bioreactor. Use scissors to cut the trachea 

longitudinally into two semi-cylinder sections (i.e., upper and lower sections) on 

days 1 and 4 of in vitro culture to expose the inner surfaces for monitoring cell 

growth and calculating cell density. Use a conventional fluorescent microscope to 

visualize the cells on the inner surfaces.

12. To acquire the images using Micro-Manager software, follow steps 3.5 and 3.6. 

Use a fluorescein isothiocyanate (FITC) filter to visualize the CFSE-labeled cells 

in fluorescence mode. Analyze the images taken by the fluorescent microscope 

and calculate cell densities on upper and lower sections using the ImageJ 

software. To calculate the number of cells and the cell density, follow the steps 

below.

1. Open an image in ImageJ software and convert the image to a binary 

image (16-bit) using Image > Type >16-bit. Set the image scale with 

the scale bar using Analyze > Set Scale.

2. Adjust the threshold of the image to highlight the structures of the cells 

to count. Use Image > Adjust >Threshold. Use Analyze > Analyze 
Particles to count the number of the cells. Calculate the density of the 

cells by dividing the number of cells by the surface area of the image.

13. To assess the viability after cell seeding, use a cell viability kit. For this study, 

incubate the trachea tissue and the cells in the bioreactor at 37 °C for 6 h and 

stain the cells with 4 mM calcein-AM and 2 mM ethidium homodimer-1 in 1 mL 

of 1x PBS at room temperature for 15 min.

14. After rinsing with 1x PBS, visualize the cells using a fluorescent microscope. 

Count the live and dead cells using the steps described in step 5.12. Calculate 

cell viability as the percentage of live cells (stained with calcein-AM) per total 

cells (both live and dead cells).

Representative Results

The GRIN lens-based in situ imaging modality can allow visualization of the tracheal inner 

lumen in situ (Figure 5A). Using this imaging method, both bright-field and fluorescent 

images of the native and de-epithelialized tracheas can be obtained (Figure 5B,C). No 

fluorescent signal was observed from the native trachea prior to CFSE labeling (Figure 

5Bii). However, when the tracheal epithelium was labeled with CFSE dye, a uniform 

fluorescent signal (green) was observed throughout the epithelium (Figure 5Ci). Following 

de-epithelialization via SDS and vibration-assisted airway irrigation, the intensity of the 

fluorescent signal was decreased significantly (Figure 5Cii), indicating ablation of the 

epithelium.
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The H&E images of de-epithelialized trachea showed the removal of the pseudostratified 

epithelium from the trachea lumen and preservation of the cells and ECM microstructure 

in underlying tissue layers (Figure 6A). Moreover, pentachrome (Figure 6B) and trichrome 

staining (Figure 6C) confirmed the maintenance of the trachea tissue architecture and the 

ECM components, such as collagen and proteoglycans. Furthermore, immunofluorescence 

of epithelial cells (epithelial cell adhesion molecule, EpCAM; Figure 6D) and collagen I 

(Figure 6E) revealed complete removal of the epithelium and preservation of collagen I 

within the subepithelial tissue. SEM imaging of native trachea showed that the luminal 

surface of native rat trachea mainly was populated with multi-ciliated cells and goblet 

cells. On the other hand, SEM images of de-epithelialized trachea lumen showed that the 

basement membrane was exposed as indicated by a mesh network of ECM fibers and the 

absence of epithelial cells (Figure 6F).

Using de-epithelialized rat tracheas and fluorescently labeled cells, we investigated whether 

incorporating a hydrogel as a cell delivery vehicle could achieve homogeneous cell 

distribution onto the de-epithelialized tracheal lumen (Figure 7A,B). In this study, the 

mesenchymal stem cells (MSCs) were used as the model cells for the cell delivery and 

culture study. As described in the protocol (step 5), we instilled MSC-loaded collagen I 

pre-gel into a de-epithelialized rat trachea and monitored the distribution of the cells on 

the tracheal lumen using the GRIN lens imaging system. As a control experiment, we 

suspended MSCs in the culture medium, infused the cell-loaded culture medium into the 

trachea, and visually inspected the distribution of the cells. In situ imaging results showed 

that the fluorescently labeled cells delivered via hydrogel remained adhered more uniformly 

across the lumen than those seeded via culture medium (Figure 7B). We then tested the 

cell viability before and after cell delivery to evaluate potential cell damage and death 

due to shearing stress during cell infusion. The result showed that cell viability was not 

significantly affected by the cell delivery procedure as over 90% of cells remained viable 

(Figure 7C).

Furthermore, we cultured the cell-seeded tracheas for 4 days. The cells seeded via both 

collagen and culture medium (control) proliferated on the de-epithelialized trachea lumen 

surface as indicated by the increased number of cells expressing CFSE over time in both the 

upper and lower half of the tracheal lumen (Figure 7D). Notably, in the collagen hydrogel 

delivery group, the difference in the density of the cells between upper and lower lumens 

was smaller than that in the control group, indicating cell delivery via hydrogel promotes 

homogeneous cell distribution throughout the trachea lumen.

Discussion

In this work, we created an imaging-guided bioreactor that can allow (i) monitoring of the 

trachea lumen in situ after the cell removal and exogenous cell delivery and (ii) longterm 

in vitro culture of the cell-seeded trachea tissue. Using this custom-built bioreactor, we 

demonstrated (i) selective removal of the endogenous epithelial cells from the trachea 

lumen using detergent and vibration-assisted airway wash and (ii) uniform distribution 

of exogenous cells onto the luminal surface of the denuded trachea using cell-loaded 

collagen I pre-gel. Moreover, the GRIN lens-based imaging modality confirmed the removal 
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of the epithelium in situ. Furthermore, with further analyses, including H&E, trichrome, 

pentachrome, immunofluorescence staining, and SEM, we confirmed the removal of the 

epithelium and maintenance of the architecture and components of underlying tissue layers. 

In addition, the GRIN lens-based imaging of newly implanted exogenous MSCs showed 

the uniform distribution of the cells when collagen I pre-gel was used as a delivery 

vehicle. Lastly, the implanted cells survived and proliferated on the de-epithelialized trachea, 

highlighting the efficacy of the bioreactor in the long-term culture of the cell-seeded airway 

tissues.

The critical step in the de-epithelialization protocol is creating a thin detergent solution 

layer in the trachea lumen. In current decellularization protocols, multiple cycles of 

chemicals and enzymes are being used over a long period, reducing the number of collagen 

fibers, glycosaminoglycans (GAGs), proteoglycans, and chondrocytes, compromising the 

biological and biomechanical properties of the airway scaffold19 , 20 , 21. On the other hand, 

the ECM provides biochemical and mechanical cues and suitable physical environments for 

survival, proliferation, and differentiation of implanted exogenous cells22 , 23. The thin-film 

deposition method described in this study uses a small amount of detergent (less than 50 

μL) for the epithelium ablation while allowing preservation of the underlying tissue layer 

and subepithelial cellular components. Mechanical vibration of the detergent-exposed tissue 

demonstrated in this study is an important procedure as it permits detachment and clearance 

of the lysed cells. The cell debris and partially disrupted cells resulting from exposure of the 

epithelium to the detergent are challenging to be washed only by flooding the trachea with 

the washing solution. Therefore, mechanically vibrating the trachea during washing provides 

sufficient shear forces to clear the cell debris from the tracheal lumen.

In general, the pre-gel-based cell seeding approach can be influenced by delivery speed, 

the viscosity of the pregel (that is directly related to the pre-gel concentration), surface 

tension, and gelation time. In particular, during pre-gel preparation, it is essential to maintain 

the pre-gel concentration low enough to transport the cell-suspended pre-gel in the tubing 

and high enough to maintain the cells on the upper surface of the trachea. Therefore, it is 

strongly recommended to find the optimum concentration for each pregel by testing various 

concentrations. In addition, practice the delivery technique such as the delivery speed with 

less precious cells to ensure the successful delivery of the cell-loaded pre-gel. Moreover, 

while we used MSCs as a cell model to demonstrate (i) the distribution of the cells with 

pre-gel as a delivery vehicle and (ii) the capability of the bioreactor system for culturing the 

newly seeded cells on denuded trachea lumen, the use of stem cells (e.g., basal cells) and 

primary airway epithelial cells in future studies could allow studying cell differentiation and 

functional epithelial cell regeneration24 , 25. In addition, future studies can include adding 

an air-liquid interface (ALI) to the current platform to generate in vivo-like shear stress on 

seeded cells for the generation of functional epithelium. To add ALI to the current device, 

a small animal ventilator can be connected to the trachea inlet to ventilate the trachea. 

Moreover, to achieve the ALI, the thin-film deposition method can be utilized to instill a 

culture medium liquid plug into the cell-seeded trachea. The thickness of the liquid film can 

be modulated by changing the liquid plug velocity26 , 27. The plug can be initiated after the 

newly seeded cells adhere and engraft firmly onto the trachea lumen.
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In addition, in situ GRIN lens-based imaging approach used in this protocol is critical for 

confirming the efficacy of the de-epithelialization and assessing the quality of distribution 

of newly seeded cells. Unlike conventional tissue analyses methods, such as histology 

and immunofluorescence, which require dissecting the samples from the trachea tissue for 

analysis, the imaging platform developed in our study allows rapid and non-destructive 

monitoring of the airway lumen during de-epithelialization and cell delivery. To keep the 

trachea sterilized during in situ imaging, make sure to sterilize the GRIN lens by wiping 

it with 70% IPA or ethanol before introducing it into the trachea lumen. Moreover, to 

image the cells using the GRIN lens, the cells (either endogenous tracheal epithelial cells or 

newly implanted cells) can be labeled with various fluorescent dyes with different excitation/

emission wavelengths. To do this, make sure to use the appropriate laser light generator to 

excite the fluorescently labeled cells and integrate the right filter lenses to the dual-edge 

super-resolution dichroic mirror.

Despite the novelty and innovativeness of the de-epithelialization, cell delivery, and in 
situ imaging methods, this study has several limitations. The de-epithelialization and cell 

delivery methods described in this study are applicable to small airways (diameter: less 

than 3-4 mm) where the surface tension is dominant. Forming a liquid plug and creating 

a thin film of the de-epithelialization solution or cell-loaded pre-gel suspension in larger 

airways, such as swine and human trachea, or bronchi, can be challenging as the surface 

tension becomes negligible compared with other forces, gravity in particular. Moreover, 

by using the thin-film deposition approach and modulating time and concentration, we 

were able to ablate the epithelium with a strong detergent (SDS) and preserve the 

underlying tissue layer. In future studies, however, milder decellularization detergents, 

such as 3-[(3-cholamidopropyl)-dimethylammonio]-1-propanesulfonate (CHAPS)28, or 

nondetergent solution, such as sodium hydroxide (NaOH)29, can be tested for the 

preservation of ECM components and support of newly implanted cells. Furthermore, the 

fluorescence intensity of CFSE-labeled cells reduces over time due to the division of the 

cells. In our study, the fluorescent images of MSCs cultured on the de-epithelialized tracheas 

for 4 days showed a substantial decrease in their fluorescence intensity. For prolonged 

monitoring and tracking of exogenous cells seeded onto the tissue scaffolds, different cell 

labeling methods that can allow long-term or permanent fluorescent labeling of the cells 

would be necessary.

We envision that the imaging-guided bioreactor platform and cell removal and delivery 

protocols described in this report can allow the creation of de-epithelialized airway tissue 

scaffolds that can be used to generate the bioengineered airway tissues. Such in vitro airways 

can offer high-fidelity in vitro modeling of human airway diseases and drug screening. 

For example, to establish functional airway epithelium, airway basal stem cells can be first 

implanted onto the de-epithelialized airway tissue30. Then, the air-liquid interface (ALI), 

which is critical for the differentiation of basal stem cells into various epithelial cells, can 

be generated within the trachea. Moreover, the in situ imaging system can be modified and 

used to fluorescently visualize the respiratory tract of patients with lung airway disorders. 

To be used clinically to evaluate airway tissues in situ, the rigid GRIN lens can be replaced 

with flexible optical fiber imaging probes to navigate the airways. Furthermore, the ability 

to homogeneously distribute the cells inside the respiratory tract using hydrogel-based cell 
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seeding can provide an unprecedented opportunity to replace damaged or injured epithelium 

in patients. In particular, the cell replacement approach developed and used in this study can 

accelerate cell-based treatment for treating respiratory disorders, such as cystic fibrosis and 

primary ciliary dyskinesia, and repairing donor lungs that are refused for transplantation due 

to severely injured airway tissues31 , 32 , 33 , 34.
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Figure 1: Three-dimensional (3D) computer drawing of the trachea bioreactor.
(A) (i) side view, (ii) top view. (B) The dimensions of the bioreactor chamber. (C) A 

transparent acrylic plastic sheet is cut and attached to the top of the main chamber using 

screws. Unit = mm; R = radius.
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Figure 2: Custom-built micro-fiber imaging for in situ visualization of the rat trachea.
(A) (i) Schematic of the imaging setup components of the light path. Abbreviations: C 

= camera, TL = tube lens, F = filter, DM = dichroic mirror, OL = objective lens; (ii) 

photograph of the imaging setup components showing the imaging probe (GRIN lens) is 

inserted in the Luer connector of the bioreactor. (B) Schematic showing that the GRIN lens 

is integrated with the bioreactor. (C) A photograph showing the imaging probe is used to 

visualize the trachea inside the bioreactor.
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Figure 3: The platform for de-epithelialization of rat trachea.
(A) Photograph showing the experimental setup for de-epithelialization and in situ optical 

fiber imaging. (B) Diagram showing the component and assembly of the custom-built 

electromagnetic shaker used to facilitate epithelium removal, ω: frequency, a: amplitude 

(C) Schematic showing the workflow of rat trachea de-epithelialization procedure. PBS = 

phosphate-buffered saline.
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Figure 4: Delivery of exogenous cells into de-epithelialized rat trachea using hydrogel.
Schematic showing hydrogel solution used as a delivery vehicle to topically deposit the cells 

onto the inner lumen of the de-epithelized rat trachea.
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Figure 5: In situ imaging of de-epithelialized trachea.
(A) Photograph showing fluorescent imaging of the trachea lumen while the CFSE-labeled 

epithelium is excited with 488 nm blue laser through GRIN lens. (B) (i) Bright-field and 

(ii) fluorescence images of the trachea lumen before epithelium labeling. (C) Fluorescence 

images of the (i) native and (ii) de-epithelialized trachea (De-Epi trachea) while the 

epithelium is labeled with CFSE fluorescent dye.
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Figure 6: Histology, immunofluorescence, and SEM analyses of native and de-epithelialized rat 
tracheas.
(A) H&E staining. (B) Pentachrome staining where purple is cell cytoplasm, blue is cell 

nuclei, green is proteoglycans (e.g., mucin), and yellow is collagen fibers. (C) Trichrome 

staining where pink is cell cytoplasm, dark blue is cell nuclei, and blue is collagen. 

Fluorescence images of native and de-epithelialized tracheas. (D) EpCAM and (E) collagen 

I. Arrowheads show the surface of the trachea lumen. (F) SEM micrographs of the trachea 

lumen.
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Figure 7: Topical deposition of the exogenous MSCs in the trachea lumen.
(A) (i) Bright field and (ii) fluorescence images of the de-epithelialized trachea. (B) 

Fluorescent images of the de-epithelialized trachea lumen when it is seeded with (i) PBS and 

(ii) collagen I pre-gel. The homogenous distribution of the cells onto the trachea lumen is 

achieved when pre-gel collagen is used as a delivery vehicle for cells. (C) (i) Fluorescent 

images and (ii) quantified viability of the cells before and after 6 h of delivery by pre-gel 

collagen. n: number of samples. Steps 5.1 and 5.17 of the protocol were followed to assess 

the viability of the cells. (D) Cell seeding density measured after (i) 1 day and (ii) 4 days 

after cell seeding and culture. The cell density was calculated by dividing cell numbers 

by the examined surface area. All values represent mean ± standard deviation. One-way 

analysis of variance (ANOVA) was used to determine statistically significant differences 

between groups, with p < 0.05 considered significant. Abbreviations: CM = culture medium, 

C = collagen. *p < 0.05. **p < 0.01. ns: not significant. No significant difference (ns) 

between upper and lower surfaces means uniform cell distribution across the circumference 

of the trachea.
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Materials

Name Company Catalog Number Comments

1× PBS Gibco, Thermo Fisher Scientific 10-010-031

3-port connector World Precision Instruments 14048-20

4-port connector World Precision Instruments 14047-10

Accelerometer STMicroelectronics IIS3DWBTR

Achromatic doublet Thorlabs AC254-150-A-ML

Aluminum pin stub TED PELLA 16111

Antibiotic-antimycotic Thermo Fisher Scientific 15240062

Assembly rod Thorlabs ER1

Button head screws McMaster-Carr 91255A274

Cage cube Thorlabs C4W

Carbon double-sided conductive tape TED PELLA 16073

CFSE labelling kit Abcam ab113853

Citrisolv (clearing agent) Decon 1061

C-mount adapter Thorlabs SM1A9

Collagen I Advanced BioMatrix 5153

Conductive liquid silver paint TED PELLA 16034

Dichroic mirror Semrock DI03-R488 Reflected laser 
wavelengths: 
473.0 +− 2 nm 
488.0 +3/−2 nm

Dulbecco's modified Eagle’s medium Gibco, Thermo Fisher Scientific 11965118

Female luer bulkhead to hose barb adapter Cole-Parmer EW-45501-30

Female luer to tubing barb Cole-Parmer EW-45508-03

Female to male luer connector Cole-Parmer ZY-45508-80

Fetal bovine serum Gibco, Thermo Fisher Scientific 10082147

Filter lens Chroma Technology Corp ET535/50m

Fluorescent microscope Nikon Eclipse E1000 - D

Fusion 360 Autodesk

Hex nut McMaster-Carr 91813A160

Hexamethyldisilazane (HMDS) Fisher Scientifc AC120585000

Imaging fiber SELFOC, NSG group GRIN lens

Laser Opto Engine MDL-D-488-150mW

Lens tubes Thorlabs SM1L40

LIVE/DEAD Viability/Cytotoxicity Kit (Invitrogen) Thermo Fisher Scientific L3224

MACH 3 CNC Control Software Newfangled Solutions

Objective lens Olympus UCPLFLN20X

Peristaltic Pump Cole Parmer L/S standard digital pump 
system

Recombinant human FGF-basic PeproTech 100-18B
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Name Company Catalog Number Comments

Retaining ring Thorlabs SM1RR

Scientific CMOS camera PCO Panda PCO Panda 4.2

Sodium dodecyl sulfate VWR 97064-472

Solidworks (2019) Dassault Systemes

Stackable lens tube Thorlabs SM1L10

Subwoofer plate amplifier Dayton Audio SPA250DSP

Subwoofer speaker Dayton Audio RSS21OHO-4 Diaphragm 
diameter: 21 cm

Syringe Pump World Precision Instruments AL-4000

Threaded cage plate Thorlabs CP33

Threaded luer adapter Cole-Parmer EW-45513-81

Tube lens Thorlabs AC254-150-A-ML

Tygon Tubing Cole-Parmer 13-200-110

XY Translator Thorlabs CXY1

J Vis Exp. Author manuscript; available in PMC 2022 June 17.


	Abstract
	Introduction
	Protocol
	Design and construction of imaging-guided rat trachea bioreactor
	Isolation of the rat trachea
	Imaging-guided removal of the trachea epithelium
	Trachea tissue preparation for further analyses
	Homogeneous distribution of exogenous cells onto the denuded tracheal lumen

	Representative Results
	Discussion
	References
	Figure 1:
	Figure 2:
	Figure 3:
	Figure 4:
	Figure 5:
	Figure 6:
	Figure 7:
	Table T1

